ESTUDO DE DIVERSOS TIPOS DE CONTRAVENTAMENTO EM TRELICAS
PLANAS USANDO O ABAQUS 6.12 STUDENT EDITION

1. INTRODUCAO

1.1.DESCRICAO DO ELEMENTO DE TRELICA PLANA:

O exemplo apresentado a seguir visa o estudo de diversos tipos de
contraventamento (geometria) para trelicas planas e as alteragcdes que
provocam nos esforgos internos (axiais) de suas barras. Trata-se de uma trelica
plana formando um cavalete com 6 metros de altura e 2 metros de largura
submetida a 1 condicdo de carregamento. A figura 1 mostra 3 tipos de

contraventamento (geometria) propostos e o carregamento atuante.
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Figura 1. Geometrias da trelica a serem analisadas. (a) Contraventamento tipo

K. (b) Contraventamento em diamante. (c) Contraventamento em X.

1.2. PROPRIEDADES GEOMETRICAS

Area das secdes transversais das barras que compde as colunas
(montantes): 9.27 [cm?].

Area das sec6es transversais das barras diagonais: 7.66 [cm?].



1.3.PROPRIEDADES DOS MATERIAIS
‘Modulo de elasticidade do material das barras: 20500 [kN/cm2] (ago

estrutural).
2. RESOLUCAO
O procedimento de resolucdo pode ser demonstrado no seguinte

fluxograma (a ordem pode eventualmente ser quebrada em pontos especificos

por conveniéncia):



PRE-PROCESSAMENTO

Inicio da Analise

Criagdo da geometria base (Parts)

Definir Tipo de Elementos

Atribuicdo das propriedades dos
materiais (Materials)

Atribuicdo das propriedades das
sec¢oes das barras (Sections)

Associa¢do das SecOes, geometria
base, materiais... (Section
Assignments) (Assembly)

Aplicar¢ao das condigoes de
contorno

Cargas (Loads)

Apoios (BCs)

Criagdo da geometria da malha
(Mesh)

Elementos calculaveis pelo
método dos elementos finitos.
Aproximagdo da estrutura real.

_IDefinigﬁo das Variaveis de Sal'daI

(Field Output Requests)

PROCESSAMENTO

Solugdo, Calculos
Computacionais (Jobs)

POS-PROCESSAMENTO

Andlise dos resultados

Variavéis de saida

Analise grafica




2.1.INICIO DA ANALISE

v' Se vocé ainda nao iniciou o programa Abaqus/CAE, digite cmd no
Menu Iniciar para abrir o Prompt de Comando e nele digite
abg6122se cae para executar o Abaqus.

v" Em Create Model Database na caixa Start Session que aparece,

selecione With Standard/Explicit Model.

2.2.PRE-PROCESSAMENTO
v No menu Model a esquerda, cligue com o botdo direito em Model-1 e

selecione Rename. Digite Estruturadetrelicas.
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[ A nev nodel database has been created
‘ [ |The nodel “Hodel-1- has been created
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v" No menu Model a esquerda, dé duplo clique em Parts, no campo Name
digite Trelica tipo K, e selecione as opgbes: 2D Planar, Deformable,

Wire. Em approximate size digite 20. Clique em Continue...
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v' Para comecar a criar a estrutura, cligue em Create Lines: Connected
na caixa de ferramentas e insira em ordem as seguintes coordenadas
(tecle enter entre uma e outra coordenada): 0,0 - 0,1.5-0,3-0,45-0,6
-16-26-245-23-215-20-115-215-13-23-145-
245-16-045-145-03-1,3-0,1.5-1,1.5-0,0. Em seguida,
desative a funcédo Create Lines: Connected, cligue em Auto-Fit View

na barra de ferramentas e clique em Done.
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A nev model database has been created
m The model "Model-1" has been created
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v" No menu Model a esquerda, d¢ duplo clique em Materials. Digite Ago
estrutural no campo Name, E cliqgue em
Mechanical>Elasticity>Elastic. Em Data, no campo Young’s Modulus
digite 205E9 e cligue OK.
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A new model database has been created
m The model “"Model-1" has been created.
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v No menu Model a esquerda, dé duplo clique em Sections. No campo
Name digite Montantes, em Category selecione Beam, e em Type

selecione Truss. Clique em Continue...
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A new model database has been created
m The model “Model-1" has been created.
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v’ Selecione o Material (aco estrutural) e em Cross-sectional area,

escreva a areade 9.27E-4. Cligue em OK.
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|A new model database has been created
fThe model “Model-1" has been created.
.

v/ Repita o ultimo procedimento para criar a secao das barras diagonais

(Name: diagonal), com area de 7.66E-4.
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[& nev nodel database has been created
[ |The model “Hodel-1- hes been created.
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v" No menu Model a esquerda, abra Parts>trelica tipo K e dé duplo

clique em Section Assignments.

Selecione as barras de fora

(montantes) e cligue em Done. Selecione a se¢ado montantes e clique
em OK.
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A new model database has been created
E The model “"Model-1" has been created.
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v Repita este procedimento, selecionando as barras do interior da trelica,

associando a secao diagonal.
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A nev model database has been created
The model "Model-1" has been created
»ﬂl

v" No menu Model a esquerda, abra Assembly e dé duplo clique em
Instances. Certifigue-se que o Instance Type consta em “Dependent

(mesh on part)” e cligue em OK.



e R STV [ e il N 10

[Z] File Model Viewport View Instance Constraint Feature Tools Plug-ins Help K? -] (8[|

DEESE i «EBNIBA RS Gl B0 S50 0 @00 K ) (R 8 sty s [ - K 5

Model | Results Module: [2 Assembly  [v] Modek: [Z Estruturadetrelica [f] step: [ iniial ]
Svi: ® = 9 @
Models (1) gl N ﬂP
Estruturadetrelica > & Create listance P
5 Parts (1) [ s
B Tvdga:lpo K Iz © Parts
A e
¥ ica tipo K
@y Sets 2) Ll, g-,_,‘
~ Sufaces P
@ Skins !
Stringers | = =
® % Se:h:n A R, =,
B Orientatio & B!.. Instance Type
B, Composity | .\, A ® Dependent (mesh on part)
4 Engineerir AN, :
P y ) Independent (mesh on instance)
=0 A
@2 Materials (1) s Note: To change 3 Dependent instance's
& Calibrations 1 mesh, you must edit its part's mesh.
8 Sections 2) 77 Auto-offset from other instances
# Profiles
=4 Acerit =) =
[vunces|
% Position Cont
& Features
{7 sets v
& Surfaces
{8 ConnectorAs I
45 Engineering F N
o Steps (1)

B Field Output Req
Bt bictan Ot R ™
mn »

4= [X] Select the parts to instance from the dialog 25 simuLia

A new model database has been created
m ‘The model “Model-1" has been created.
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v" No menu model a esquerda, dé duplo cligue em Steps. No campo
Name, digite Carregamento e em Procedure Type, selecione Linear
pertubation>Static Linear pertubation. Clique em Continue.... Entdo

cligue OK na nova janela que se abre.
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A new model database has been created
m ‘The model “Model-1" has been created.
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v No menu model a esquerda, d¢ duplo cligue em BCs. Na janela Create
Boundary Condition, altere o campo Name para Apoio Fixo, Step para
Initial e Types for Selected Step para Displacement/Rotation. Clique

em Continue....
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A new model database has been created
m The model “"Model-1" has been created.
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v’ Selecione os pontos inferiores da estrutura e cligue em Done. Marque

na nova janela Ul e U2. Clique em OK.
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A nev model database has been created
m The model "Model-1" has been created.
Varning: Cennot continue yet—complete the step or cancel the procedure.
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v No menu model a esquerda, d¢ duplo clique em Loads. Na janela
Create Load, no campo Name digite Cargas horizontais, troque o Step

para carregamentos e cligue em Continue....
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Varning: Cannot continue yet——complete the step or cancel the procedure

|A nev model database has been created
m | The model "Model-1" has been created
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v’ Selecione os quatro nés da barra esquerda, acima do apoio esquerdo, e
cligue em Done. Na janela Edit Load, no campo CF1 digite 10000 e

cligue em OK.
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‘T Interactions 5 CSYS: (Global) [p A
B intenction Profll| T B Distribution: | Uniform [ o
$#{ contact Contrc fis [“_ : —
i Contact Initiai g 1 10000 |
& Contact Stabili gl * o |
€] Constraints 13
4B ConnectorSec| | =7, ., [ Follow nodal rotation

@ F Fields Note: Force will be applied per node.
Py Amplitudes —
[ [ox]

@[5 BCs )
s Predefined Fiel -
Bl Remeshing Rul
X Optimization T
I Sketches v

¥ Annotations
# Analysis 1_' %

& Jobs

Y Adaptivity Process| |

B Co-executions

o =y | [#[X] Fill out the Edit Losd dialog 25 simuLia

A new model database has been created
El | The model "Model-1" has been created.
Varning: Cannot continue yet--complete the step or cancel the procedure.

ball

v Repita o procedimento para criar a Cargas verticais, aplicada nos
pontos da extremidade superior da estrutura de intensidade -20000
(CF2).
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& Connector, * Tow
#4g Engineering & Editload ]
0% Steps (2) 55

58 Field OutputRs Name: Cargas verticais
& F-Output-1 o Type  Concentrated force

@ B History Output B s Step:  Camegamento (Static, Linear perturbation)
I Time Points - Region: Set3
Bp ALE Adaptive b !
‘G Interactions = CSYS: (Global) [y A
B Intemction boo R, fm, Distribution: | Uniform o
${ Contact Contrc fis [1‘.
it Contactinitiali |~ * CFL: |
i@ Contact Stabili o 4 o ooy ‘

Constraints n by

B Comectorsec | =V, A, [ Follow nodal rotation

@ F Fields Note: Force will be applied per node.
Py Amplitudes

) ) =

@[5 BCs (1) —
[ Predefined Fiel| -
B Remeshing Rulr
X Optimization T
[ Sketches | ¥

¥ Annotations
3 Analysis I i
2 Jobs

Y Adaptivity Process| |
BE Co-executions _| .
2oei— o~y | [4el[X] Fillout the Edit Load dialog 25 simuuia
B[R oot Satabase bas been crented

The nodel "Model-1" has been created.
Varning: Cannot continue yet—-complete the step or cancel the procedure

Bl

v" No menu model a esquerda, abra Parts>trelica e dé dois cligues em
Mesh. Na barra de contexto, em Object, selecione Part. Na barra do
menu principal, clicue em Mesh>Element Type e selecione com o
mouse toda a regido da treliga, formando uma “caixa”. Clicando em
Done, abrira a janela Element Type. Em Family, selecione Truss e

cligue OK.
5 oo e Edon 6 g vz 1 T e —=

File Model Viewport View Seed Mesh Adaptivity Festure Tools Plug-ins Help X? = [ |
DERSE & ¢ CLEINHEA: A 18l @F0 0@ oK) CR.E B Mo [ LB
S 3 i iect: |- Treliga tipo K v

Model | Results -
T £ Element Type 3
EEECE
T Element Library Family
adetrelica ® Standard © Bxplicit  Piezoelectric 2
arts (1) Pipe
religa tipo K gl | Geometric Order Thermal Electric E|
& Features (1) @ @ Linear © Quadratic M 5
by sets @) 4
~ Sudaces B -
® Skins | tine |
¢ Stringers A B e 7] Hybrid formulation
b %% Section Assignme TLL'H” it
B Orientations ! ement Lontrols
B Composite Layup; | _, _ Scaling factors: Linear bulk viscosity: |1
54 Engineering Featu | %, 4
;M Mesh (Empty) Ly
Materials (1) —=
Calibrations. o R ,t\
Jections (2) o
rofiles Kot/ |

Assembly {a 4

B Instances (1)

I Position Constraints | | b
L Features (1)

7 Sets (5) % Note: To select an element shape for meshing,

¥ Surfaces select "Mesh->Controls® from the main menu bar.

T2D2: A 2-node linear 2-D truss.

3 Connector Assignme

& Engineering Features Lok | [ Defauts | [ Concel |

iteps @)

field Output Requests (1

Qe v | [45)[X] setthe data using the Element Type dislog Zs simuLin

A nev model database has been created

Th odel “"Model-1" has been created.

|Harning. Cannot continue yet——complete the step or cancel the procedurs.
22

v" Na barra do menu principal, clique em Seed>Edges e selecione toda a

regido da trelica novamente e cliqgue em Done. Na janela Local Seeds,




altere Method para By number e em Sizing Controls, altere Number

of elements para 1. Cligue em OK.
S5 Abaqs/CAE StudentEdi 1 . TSilhe™ el e = | @

File Model Viewport View Seed Mesh Adsptivity Festwre Toos Plugeins Help A?
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| & Sufaces B ;
el S —
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b & Section Assignme| | =
| Bw Orientations !
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74 Engineering Featu , B, Sél Creatino,

4 s B,‘_ 7] Create set with name: |Edge Seeds-1
Materials (1) =
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B Instances (1) J\A B
B position Constraints | | $b
L Features (1) o
7 Sets (5) 'X ¥
¥ Sufaces
3 Connector Assignme I
& Engineering Features *
iteps (2)
Vield Output Requests (L
[Qutmedd - 4[] set the data using local seed dial X
[ > using local seed dialog 7S simuLia

A nev model database has been created
m The model "Model-1" has been created.
Varning: Cennot continue yet—complete the step or cancel the procedure.

bl

v' Na barra do menu principal, clique em Mesh>Part. Aparecera a
pergunta “OK to mesh the part?”, cligue Yes. Perceba que a trelica fica

na cor azul.
2 Abaqus/CAE R 1 —

Fle Model Viewpot View Seed Mesh Adeptiviy Feotwe Tools Plugiins Help 7
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B Instances (1)

K Position Constraints
L Features (1)

7 Sets (5) ¥

Vv Surfaces

3 Connector Assignme I "

R Engineering Features

iteps @)
Vield Output Requests (L
f?'""'""x‘ 0 y 4 |X] OKto mesh the part? [No] 25 simuLia

A nev model database has been created
m The model "Model-1" has been created.

Varning: Cannot continue yet--complete the step or cancel the procedure
)Q

2.3.PROCESSAMENTO



v" . No menu model a esquerda, duplo clique em Jobs. Na janela Create

Job, apenas cliqgue em Continue.... Na janela Edit Job, cligue em OK
£ soncicn udenEan o1 e 1 [ oMl T S SL

(3] File Model Viewport View Job Adaptivity Co-erecution Optimization Tools Plug-ins Help ?
DEEes s +c ARUEARN __ HeOsEE00 880
Model | Results Module: £/ 10b [ Modet [£ ica ] step: [F 5
S:on Y8
&= Lonne
(#4 Engine: @u B & Create Job =
0% Steps (2) :
52 Field Outp L= | Name: Job-1

@ F-Output-1 5 Source: Model |v|
@ Bp History O ﬂ.x = ]

B oni o

Bp ALE Adapt
T Interactior
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#{ Contact i
4 Contactin
A& Contact St | D
B oo (o) o |

@ F Fields S —
Py Amplitude

@[ Loads 2)

b BCs (1)
[ Predefinec
Ejg Remeshing
BX Optimizati
I Sketches

N Annotations v
=48 Analysis

2

By Adaptivity Pr¢

B8 Co-execution| |

#X Optimization ~
< (il »

A new model database has been created

The model “Model-1" has been created.

Varning: Cannot continue yet—-complete the step or cancel the procedure
3] 24 elements have been generated on part: Trelica tipo K

.

&) [x

Phug o [ ] Me
/> !

p)
2S simuLiA

v’ Abra Jobs e cligue com o botao direito em Job-1. Clique em Submit.
Se aparecer uma janela dizendo “Job files already exist for Job-1. OK to
overwrite?”, clique OK. Aguarde o processamento dos dados. Estara

concluido quando aparecer “(Completed)” ao lado de Job-1 no menu
model a esquerda.
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B Field Output Reques
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b5 Time Points
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4& Contact Initialization
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«J] Constraints

{8 Connector Sections

F Fields

Py Amplitudes

@ [ Loads 2)

@ BCs ()
[ Predefined Fields
Elg Remeshing Rules
X Optimization Tasks
I Sketches

N4 Annotations ¥

8% Analysis l
5 & liobs 0} *
B Adaptivity Processes

B8 Co-executions -
< i ] '

The job input file "Job-1.inp® has been submitted for analysis
Job Job-1: Analysis Input File Processor completed successfully
b2 ;

il

B
2S simuLiAa

Job Job-1: Abaqus/Standard completed successfully.
>3]/ Job Job-1 completed successfully

2.4.POS-PROCESSAMENTO



bY

v" No menu model a esquerda, clique com o botdo direito em Job-

1(Completed)>Results. A tela de analise de dados se abrir4. Na caixa

de ferramentas, cligue em Plot Contours on Deformed Shape.
5 honci/cht sudeEsvo 612G Vv 1 [ &~ el BE W

[Z] File Model Viewport View Result Plot Animate Report Options Tools Plug-ins Help X?

L
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The job input file "Job-1.inp" has been submitted for analysis

Job Job-1: Analysis Input

3 Fi
Job Job-1: Abagi
Gl [an Job-1 completed successfully

le Processor cmpleted successfully

jus/Standard completed successful

v Na barra de ferramentas no canto superior a direita, selecione S11

onde, por padrdo, estava selecionado Mises. Na caixa de ferramentas,

cligue em Common Options. Na janela Common Plot Options,

selecione a aba Labels e marque Show element labels e show node

labels. Clique OK.
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w

Job Job-1: Ab:

The job input file "Job-1.inp" has been submitted for analysis
Job Job-1: dnalysis Input File Processor completed successtully
aqus/St.

andard completed successful
[l Job Job-1 completed successfully




v" Na barra de menu principal, cligue em Viewport>Viewport Annotation
Options.... Na janela aberta, selecione a aba Legend. Cligue em Set
Font. Na nova janela, aliere Size para 14. Cliqgue OK nas duas janelas
abertas. Os esfor¢cos nas barras ja estdo exibidos em escala de

cores, mas € possivel ainda salvar os valores dos esforcos em um
documento de texto.
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The job input file "Job-1.inp" has been submitted for analysis
El Job Job-1: Analysis Input File Processor completed successfully
| Job Job-1: Abaqus/Standard completed successfully.
|53l Job Job-1 completed successfully

v" Na barra de menu principal, clioue em Report>Field Output. Na janela
Report Field Output, cligue em S: Stress components>S11 e clique
em OK. A mensagem aparecera: “The field output report was appended

to file “abaqus.rpt”.” O arquivo abaqus.rpt pode ser encontrado em
C:\Users\"Nome do Usuario”\abaqus.rpt.
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@@l Output Detabeses (1) BR[| CAva: 75%) Variable | Setup |
@ &5 Model Database (1) = +4.707e+07 -
£l ectrums (7) +3,730e+
0 se @ 317300+07 Output Variables
BB XVPlots 12 Position: Integration Point  [v]
& xvata ARnresio Click checkboxes o edit the identifiers shown next to Edit below.
L om0 isseter s icsoiulnmion :
# [ Display Groups -2.129e+ s
B Feee Bty e 5. 106et07 [ v @ 5: Stress components
& Sweams -4.082e+07 | [ Mises
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/\ Edit: | SS11
- btk oriode % % Section point:
I x IS TR 2ot [ox ] [y | [pefauts] [ concel
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25 simuLia
[The job input file "Job-1.inp" has been submitted for analysis B
[ |3b Job-1""Analysis Input File Brocessor comploted successtully i
Job Job-1: Abaqus/Standard completed successfully. =)
[33ll.Job Jeb-1 compieted successfully =
v" O arquivo listara os esforcos das barras
) sbaqusrpt - Bocode notas I T — - ul

Arquivo  Editar  Formatar Exbir  Ajuds

Element Int S.S11
Label [43 @Loc 1
1 1 47.0699e+06
2 1 || -47.0699E+06
4 1 19.5822E+06
5 1 | -32.6371E+06

7 1 | -26.1097e+

8 1 35.3024
10 1 -35.3024E
12 1 13. 8|

14 1 -19. 5822E.

15 1 23.5349E+
16 1 -23.5349E+06
18 1 6.52741E+06
21 1 11.7675E+06
23 1 -11.7675E+06
Minimum -47.0699E+06
At Element 2
Int Pt 1
Maximum 47.0699E+06
At Element 1
Int Pt 1
Total -39.1645E+06

Field output reported at integration points for

region: Trelica tipo K-1.Region_2

Element Int S.S11
Label [43 @Loc 1
3 1 |-70.1187€+06
6 1 2.69687E+06
9 1 26.9687E+
11 X -45.8468E
13 1
17 1
19 1
20 1 | -10.7875E+06
22 1 -21.5750E+06
24 1 0.
Minimum -70.1187€+06
3

At Element
Int Pt

maximum
At Element

1
26. 9687E+Og

i

v" Na barra do menu principal, cligue em Report Field Output. Na janela

Report Field Output, desmarque Stress Components e no campo

Position

selecione

Unique Nodal.

Displacement e clique OK.

Entdo marque

U:Spatial
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pectrums +3.7306+07 /
~E XYPlots +2.7546+07 | Frame: 1 (gtenliiam
B9 xvDsta +1.777e+07 :
+8.007e+06 Variable | Set
[ paths 17596406 =
T Display Groups (1) é %géﬁg; Output Variables
-2.129¢e+
B Free Body Cuts Sibeatal Position: |Unique Nodal E
B streams -3.0B2e+07
T Movies 5 0596407 Click checkboxes or edit the identifiers shown next to Edit below.
-6.035e+07
B images CZ012e+07 p [7] CF: Point loads.
P[] E Strain components
P[] RF: Reaction force
P [C]5: Stress components
P [711U: Spatial displacement!
3 ODE: J0-1.040  Abaqux/ Slandand Sludenl EJlan B.12:2 Thu E2p 12 De’,ss' 16 £, Soutn Amara Sisfaana Tome 2013
I \ edit: [u
Sicp: Canegamenia
b X faamenl 0 Slas T = 22200616
Frmary var: 5, 511 Section point: Al
Bt T " ko matian Soak Factas 413562402
Al ok | [ Apply | [Defauts| [ Caneel |

The model database "C:\Users\GustavoN\Dropbox“METODO DOS ELEMENTOS FINITOS“AULA 3“OFICIAL - AULA 3.cas" has been apensd

The job input file

"Job-1.inp" has been submitted for analysis

Job Job-1: Analysis Input File Processor completed successfully
Job Job-1: Abaqus-Standard completed successfully
Job Job-1 completed successtully

v' O arquivo listara as deformacgfes das barras.
_——

7] abaqus.rpt - Bloco de notas 1
Arquivo Editar Formater Exbir Ajuda

Int Pt 1 -
Maximum 26.9687E+06
At Element 9
1
Total -183. 3876406

Field output Report, written wed Sep 11 17:19:30 2013

source 1

0DB: C:/users/Felipe Diniz/Job-1.odb
Step: Carregamento

Frame: Increment
Loc 1 : Nodal values from source 1

output sorted by column "Node Label™.

1: Step Time =  2.2200e-16

Field output reported at nodes for part: Trelica tipo K-1

Node U.Magnitude u.ul u.u2
Label @Loc 1 @Loc 1 @Loc 1
1 0. 20.0000E-33 55.0000E-33
2 746.229e-06 746.229e-06 000E-33
3 0. 20.0000€-33 -95.0000€-33
4 985.790E-06 841.753E-06 -513.063E-06
5 926. 689e-06 905.435€-06 197.332e-06
6 2.10465E-03 2.09343e-03 217.065

7 1.97080e-03 1.96606E-03 -136. 638e-06
8 2.19997e-03 2.02974e-03 -848. 528E-06
9 3.33152e-03 3.32942e-03 118. 399e-06
10 3.24728e-03 3.23390E-03 -294. 504E-06
11 3.43519e-03 3.26574E-03 -1.06559e-03
12 493E-03 4.42475e-03 -39.4664E-06

13 4,39547e-03 4.37213e-03 -452.370e-06 3

14 4.54008e-03 4.37213e-03 -1.22346€-03 3
Minimum 0. 20.E-33 -1.22346€E-03
t Node 3 3 14
Maximum 4.54008e-03 4.42475e-03 217.065e-06
At Node 14 12 6
Total 32.3086E-03 31.5807e-03 -4.04082e-03

v" Na barra do menu principal, clique em File>Save As.... D& um nome ao
arquivo e clique em OK (E possivel também salvar o arquivo com os

resultados j& calculados - job-1.0db).



